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Update Orders 

Update Orders eliminates the time-consuming steps involved in changing details for dozens or hundreds 

of quotes or incomplete orders in the Sage 300 Order Entry module.  

The Update Orders screen lets you select the update action that you want to perform, the items you want 

to update, and then specify the ranges of orders that need to be updated – or import a list of the orders 
that you need to process.  

You can view and cherry-pick the list of orders, and then click the Process button to complete the 
operation in a single step. You can display a log of all changes when processing is complete. 

Update Orders lets you update selected orders to: 

• Change the components of a kit. 

• Change a bill-of-material. 

• Change the expected ship date of an item or list of items or all items. 

• Change the deliver-by date of an item or list of items or all items.* 

* Only available on Sage 300 2012 and higher versions. 

• Update prices from a price list or change the price list for an item, list of items, or all items. 

• Substitute one or more items for other items in multiple orders. 

• Change customer addresses, affecting many orders, including standing orders. 

• Put on hold a large number of orders (e.g. for one customer). 

• Remove holds from a large number of orders (e.g. for one customer).  

• Take completed orders off hold. 

• Commit an item or list of items or all items on a set of orders. 

• Uncommit an item or list of items or all items on a set of orders. 

• Change the salesperson code on a set of orders. 

• Reduce the quantity on order to zero for items that are not in stock. 

• Update the ship via code or ship via description for a set of orders. 

• Update the order reference for a set of orders. 

• Change the item location for fulfilling a set of orders. 

• Change the terms code. 

• Delete unshipped items. 

The Update Orders icon appears under TaiRox Productivity Tools > Order Entry Tools on the 

Sage 300 desktop and can be copied to other menu locations. 
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The Update Orders screen appears below: 

In the following example, the program will update the “Deliver By Date” for a range of orders that 

include a specific item. 

The range fields let you select orders by specifying a range of values for up to seven fields, including 

order numbers, order dates, customer numbers, order types, and any optional fields used for orders. 

 

Selecting and Updating Orders 

Choose what to update in each order 

First, you have to specify what needs to be updated in the orders. Update Orders provides the 

following choices: 

  

Update Order Kit Number 
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• Select “Update Order Kit Number”, then: 

o Select the Kit Item Number. 
o Specify the old Order Kit Number and new Order Kit Number. 
o Enter the ID and Password for the person approving price changes resulting from the 

different kit number. 

Notes:  

• When updating Kit numbers, it’s possible to have a price change. If this happens, authentication 
will be required and the user should provide this before proceeding. 

• To change kit details, Update Orders deletes the kit detail line from the posted order and then 
adds a new kit line with the appropriate changes – because Sage 300 does not allow it to change 
the details on a posted kit line.  

However, if an order has been partially shipped, the kit order lines cannot be deleted – this is 
also a restriction imposed by the Sage 300 Order Entry business logic – and the program will 
display an error in the log file for each partially shipped order. 

To change kit details on the partially shipped orders: 

1. Change the Qty. Ordered for the kit item line to 0.  
2. Insert a new order line, and specify the new kit number. 

Update Order BOM Number 

 

• Select “Update Order BOM Number”, then: 

o Select the Master Item Number for the BOM. 

o Specify the old Order BOM Number and new Order BOM Number. 
o Enter the ID and Password for the person approving price changes resulting from the 

different BOM number. 

Note: When updating BOM numbers, it’s possible to have a price change. If this happens, 

authentication will be required and the user should provide this before proceeding. 

Update Item Expected Ship Date 

 

• Select “Update Item Expected Ship Date”, then: 

o Choose a specific item, list of items, or all items. 

Click the Zoom/Drill-Down button to specify a list of items or to import an item list. See the 
section  on choosing items. 
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o Specify the new Expected Ship date for the items. 
o Click the Update Order Expected Ship Date Also to change the order date at the same time. 

Update Item Prices 

 

• Select “Item Prices”, then: 

o Choose a specific item, list of items, or all items.   

Click the Zoom/Drill-Down button to specify a list of items or to import an item list. See the 
section on choosing items. 

 

o Select the Price List for updating pricing. 

Substitute Items 

 

You can substitute multiple items on multiple orders in one operation – entering items directly in the 

program or importing an item substitution list from a spreadsheet. 

You can substitute a non-kit item for a kit and vice-versa. You can also choose to ignore orders if 

ANY items on the orders are shipped. 

In some situations, the price on an order should not be changed by substituting items; in other 

situations, the price should change.  Use the “Retain Existing Line Item Unit Price” checkbox to 
choose the behavior you need.  

Important: If retaining the prices for orders, authentication may be required, as O/E interprets this as 
a "price override".  

Normally, order lines with items being substituted are deleted. Choose “Retain Line . . .” to keep the 
original line but set its quantity ordered to “0”.  

• Select “Substitute items”, then: 

o Click the Zoom/Drill-Down button to specify one or more items that you are substituting or to 
import a substitution list. See Choosing a single item, list of items, or all items for more 
information. 
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Specify the “From” and “To” item numbers in the pop-up grid. 

o Select “Only Substitute Items On Orders That Have Never Been Shipped” to skip partially 

shipped orders. (Ignore ALL orders where ANY items on the orders have been shipped.) 
o Select “Retain Existing Line Item Unit Price” to keep the order prices the same – even with 

item substitution. 
o Select “Retain Line, Set Quantity Ordered to 0” to keep the original order line but set its 

quantity ordered to “0”. The new line will have a comment indicating which item it replaced. 
o Enter the ID and Password for the person approving price changes if you are not keeping 

original prices. 

Put Orders On Hold 

 

• Select “Put Orders On Hold”, then continue to choose the ranges for order selection. 

Take Orders Off Hold 

 

• Select “Take Orders Off Hold”, then continue to choose the ranges for order selection. 

o Enter the ID and Password for a credit approver if taking an order off hold requires credit 

approval. 

Note:  This selection processes only incomplete orders that are on hold. To process completed 

orders, select “Take Completed Orders Off Hold”.  

Update Addresses 

This choice lets you update addresses for customers with many orders in process or many 
standing orders. 

• You can select Bill-To Addresses or Ship-To Addresses. 

• You can recalculate taxes for orders with address changes. 

 

• Select “Update Addresses”, then: 

o Select “Update Customer Bill-To Addresses” to update the bill-to address on orders.  

o Select “Update Customer Ship-To Addresses” to update the ship-to address on orders.  
o Select “Recalculate Tax If Address Changed” to recalculate all taxes using the new 

jurisdictions, if changed. 

Note that the program will only select and update an order if the address in the order is different 

from the address in the customer record or ship-to address record. 



Update Orders Selecting and Updating Orders 

TaiRox Productivity Tools for Sage 300  6 

© 2009-2025 TaiRox Software Inc. All rights reserved.  

Update Item Deliver By Date 

 

• Select “Update Item Deliver By Date”, then: 

o Choose a specific item, list of items, or all items.   

Click the Zoom/Drill-Down button to specify a list of items or to import an item list. See the 
section below on choosing items. 

 

o Enter the new Deliver By date. 

o Select “Update Order Deliver By Date Also” to change the order date to match the item 
Deliver By date. 

Commit Quantities 

 

• Select “Commit Quantites”, then: 

o Choose a specific item, list of items, or all items.   

Click the Zoom/Drill-Down button to specify a list of items or to import an item list. See the 

section below on choosing items. 

 

o You can choose to “Only Commit Item Detail Lines That Have No Quantities Already 
Committed”. 

Uncommit Quantities 

 

• Select “Uncommit Quantites”, then: 

o Choose a specific item, list of items, or all items.   

Click the Zoom/Drill-Down button to specify a list of items or to import an item list. See the 

section below on choosing items. 
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Change Salesperson Code 

 

• Select “Change Saleperson Code”, then: 

o Specify the From and To salesperson codes. 

 

Use the Finder to look up salespeople. 

Zero Quantity Ordered For Items Not In Stock 

 

• Select “Zero Quantity Ordered For Items Not In Stock”, then: 

o Choose a specific item, list of items, or all items.   

Click the Zoom/Drill-Down button to specify a list of items or to import an item list. See the 
section below on choosing items. 

 

Note:  This choice reduces quantities to zero on orders where the items have zero quantity on hand 

at the location specified on the detail line. 

Take Completed Orders Off Hold 

 

• Select “Take Completed Orders Off Hold”, then continue to choose the ranges for order selection. 

o Enter the ID and Password for a credit approver if taking an order off hold requires credit 
approval. 

Note:  This selection processes only completed orders that are on hold. To process incomplete 
orders, select “Take Orders Off Hold”. 

Update Ship Via 

This choice lets you update the ship via code on orders, or update only the ship via description. 
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• Select “Update Ship Via Code”, then: 

o Specify the From and To ship via codes. You can also update the ship via description.  

 

Use the Finder to look up ship via codes. 

Note: The program selects orders that display the From ship via code on the Order tab, and 
updates order detail lines that have the same ship via code. 

• To change only the ship via description, select “Update Ship Via Code”, then: 

o Specify the same From and To ship via codes, and enter the new description.  

 

Update Order Reference 

This choice lets you update the reference field on orders. 

 

• Select “Update Order Reference”, then: 

o Specify the order reference text that you want to replace, and the new order reference text.  

 

The program selects orders that display the From order reference on the Order tab. 

Change Item Location 

This choice lets you change the item location for fulfilling orders. Note that the location can only be 

changed on order lines where the quantity ordered is greater than 0, and the quantity committed or 
quantity shipped is 0. 

 

• Select “Change Item Location”, then: 

o Choose a specific item, list of items, or all items.   

Click the Zoom/Drill-Down button to specify a list of items or to import an item list. See the 
section below on choosing items. 
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o Specify the “From Location” that you want to replace, and the new “To Location”.  

 

o You can also choose to “Change Order Location Also”, which changes the default item 

location in the order headers. 

 

The program selects orders with the specified From Location on item lines. 

Change Terms Code 

 

• Select “Change Terms Code”, then: 

o Specify the From and To terms codes. 

 

Use the Finder to look up terms. 

o You can also choose to “Only Change Terms On Orders That Have Never Been Shipped”.  

 

Check this box to keep the original terms on partially shipped orders. 

The program will not update orders that have been completed. 

Delete Items Not Shipped 

 

• Select “Delete Items Not Shipped”, then: 

o Choose a specific item, list of items, or all items.   

Click the Zoom/Drill-Down button to specify a list of items or to import an item list. See the 
section below on choosing items. 

 

Note:  You must delete items before you ship any items. Sage O/E does not allow you to delete 
lines from partially-shipped orders. (Partially shipped orders will NOT be loaded in the grid.)  

If orders are partially shipped, you may want to use one of the following procedures: 

o Select “Update Order > Zero Quantity Ordered for Items Not in Stock” if you are deleting 

items because they are out of stock. 
o Use Complete Orders to zero the quantity outstanding and quantity committed values for 

each incomplete line item, and set the status of each order to “complete”. 
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Choosing a single item, list of items, or all items 

 

If you are substituting items, you must create or import a list. Click the Zoom/Drill-Down 
button to proceed. 

Specific Item 

• Choose this option to update orders that contain a specific item. You can exclude orders from the 
range selection after you click the Load button.  

All Items 

• Choose this option if you do not want to restrict the update by item number. You can exclude 
orders from the selection after you click the Load button.  

List of Items 

• If you choose a list of items, the list will be remembered from the previous time you used it. 

• To create or import an item list, click on the Zoom/Drill-Down icon on the right side of the 
dropdown field. 

 

The Substitute Items list has additional columns for From and To items and Kit numbers. 

 

To insert items: 

o Use the Insert key to add more items to the list. 

o Use the Delete key to remove items. 
o The list will be remembered from the previous time you used it to update orders.  
o Click the Reset Defaults button to delete all items from the list. 

To import a list of items or item substitutions: 

o Click the Import button at the bottom of the popup form and select the spreadsheet containing 
the item list. The imported list will replace the current list of items. 

o Use the Insert key to add more rows to the list. 
o Use the Delete key to remove items from the imported list. 
o Click the Reset Defaults button to delete all items from the list. 
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Import format: 

You can find sample import files in directory \Sage300\XL61A\Documentation. 

Note:  The Excel Spreadsheet for an item list (Items.xlsx) is a single column with “ITEMNO” as 
the column heading in the first row.  

 

The Excel Spreadsheet for an item substitution list (ItemSubstitutes.xlsx) must have at least these 

four columns. The program will ignore any other column names. 

 

o Item numbers can be formatted or unformatted. 
o All other columns are ignored. This means that you can add item descriptions and notes to 

your spreadsheet without affecting the file import. 

Specify ranges of orders for updating 

You can select orders by providing order ranges and specifying additional criteria – or you can import 

a list of the orders that you need to process. 

For details on importing a list of orders, see Import a list of orders for processing. 

You can specify up to seven order fields to use for primary order selection – such as the date, order 
number, customer number, order type, ship-to location code or optional order fields (if added). The 
screen below shows a number of optional fields. 

 

• The dropdown field list shown above includes a number of standard order fields and optional 
fields, and you can add or remove fields from the dropdown list. 

Use the “Field Settings” button to customize the list of fields for selecting orders: 

Click the Field Settings button to change the fields that appear in the “Select Orders By” dropdown 
field list.  
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• The list of fields on the right are the fields that will appear in the Select Orders By dropdown.  

• To add a field to the dropdown list, select it in the list on the left, and click the Include button. 

Note regarding order dates:  

• If you choose a range of Order Dates, the default “To” date is set by a screen accessed through 
the Update Orders > File > Settings menu choice: 

 

You can override the default in the Range fields. 

Choose additional criteria if necessary 

If you want to select orders from a field that is NOT available on the Field Settings form, use 
Additional Criteria. 

 

• Click the Additional Criteria button to further restrict the orders retrieved for updating.  

• Select a field in the dropdown and click the Add button. 

• Double-click the Criteria field to enter a relationship and value. 

• Click OK to save. 
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Load the list of selected orders and choose which ones to update 

 

• Click the Load button to display the selected list of orders. 

When the Load button is pressed, the active orders that match the selection criteria will be 
displayed, allowing you to drill down on orders to confirm your selections. 

Important Note: Orders are selected for inclusion based on the moment that the Load button 
is pressed. The order may be changed before processing is completed. Make sure that you 
consult the log to see the actual processing that has taken place. 

o You can adjust the ranges or additional criteria if necessary, then click Load again. 

• Click the Select All and Select None buttons at the bottom of the screen to include all or none of 
the orders loaded in the grid. 

 

• Double-click in the Include column to “cherry-pick” orders: 

 

• Click the Order Number column heading to drill down to the selected order: 

 

Import a list of orders for processing 

You can import a list of the orders that you need to process – or you can select orders by providing 
order ranges and specifying additional criterial. 

Note that you must specify what you are updating in the “Update Order” section at the top of the form 
before you import the order list. 

For details on specifying and loading ranges of orders, see Specify ranges of orders for updating. 

To import a list of orders for updating: 

• Choose File > Import from the Update Orders menu. 
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• Select the list of orders that you want to process. 

 

• The program will import the list and load all relevant orders into the grid – setting all orders to 
“Include” – and display a message stating the number of orders that were successfully loaded, 
and the number of orders that could not be imported. 

 

The program will reject orders that cannot be processed. 

For example 

o If you specified a list of items for updating prices, the program will reject orders that do not 

include the items you specified. 
o The program will reject completed orders. 

• You can double-click the “Include” column to remove orders from the update. 

Click the Process button to update the included orders 

The program asks you to confirm your choices. Click Yes to continue. 
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Important Notes:  

• Update Orders will not change line items that have serial or lot numbers (which may be unusual 
for unshipped orders or quotes in any case). 

• There may be data-integrity errors that prevent some updates, in which case an error message 
will appear. 

• Error messages will list any orders in a list that could not be updated, along with the reasons. 

Click the Log button to confirm which orders were processed 

7/16/2020 11:12:19 AM Update Orders started. 

7/16/2020 11:12:19 AM  

7/16/2020 11:12:19 AM Performed by user: ADMIN 

7/16/2020 11:12:19 AM  

7/16/2020 11:12:19 AM Put Orders On Hold 

7/16/2020 11:12:19 AM  

7/16/2020 11:12:19 AM Order Range 

7/16/2020 11:12:19 AM     Customer Number From [1200] To [1200] 

7/16/2020 11:12:19 AM     Order Date From [7/1/2020] To [7/04/2020] 

7/16/2020 11:12:19 AM  

7/16/2020 11:12:19 AM Putting order on hold for Order Number ORD000000000065... 

7/16/2020 11:12:19 AM Putting order on hold for Order Number QT0000000000006... 

7/16/2020 11:12:19 AM  

7/16/2020 11:12:19 AM Update Orders complete. 

7/16/2020 11:12:19 AM 

================================================================================ 

The Log lists: 

• The version of TaiRox Productivity tools that’s running. 

• The user, the type of update performed, and the full range settings.  

• Each order that was processed.  

File Formats for Imported Order, Item and Item Substitution Lists 

Update Orders has several functions that let you update groups of orders and substitute items on orders 

using an imported order list and imported lists of item numbers and item substitution lists. 

Import files – orders, item lists and item substitution lists – are Excel files.  

You can find examples of import lists in directory “…\Sage300\XL61A\Documentation”. 

Order List 

Instead of specifying a range of orders and clicking the Load button, you can directly import a list of 

orders. 

The Excel Spreadsheet order list is a single column with “ORDNUMBER” as the column heading in the 

first row.  

 

• All other columns are ignored. This means that you can add item descriptions and notes to your 
spreadsheet without affecting the file import. 
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Item Lists 

You can import item lists to perform the following updates: 

• Update Item Expected Ship Date 

• Update Item Prices 

• Update Item Deliver By Date 

• Commit Quantities 

• Uncommit Quantities 

• Zero Quantities for Items not In Stock 

The Excel Spreadsheet item list is a single column with “ITEMNO” as the column heading in the first row.  

 

Notes: 

• Item numbers can be formatted or unformatted. 

• All other columns are ignored. This means that you can add item descriptions and notes to your 
spreadsheet without affecting the file import. 

Item Substitution Lists 

The Import file for substituting items is more than an item list because you have to provide the original 
item/kit number information as well as the information for the substituted item/kit. 

The Excel Spreadsheet item list must have at least these four columns. It will ignore other column names. 

 

Notes: 

• Item numbers can be formatted or unformatted. 

• All other columns are ignored, so you can add item descriptions and notes to your spreadsheet 
without affecting the file import. 
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